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Microsoft, Windows, and PowerPoint are registered trademarks of Microsoft Corporation.  All other trademarks 
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contained herein on the condition that such materials be reproduced only for classroom use; and be provided 
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prior written permission of the publisher.
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To the Teacher
Glencoe’s Presentation Plus! is an exciting multimedia 
teacher tool that enables you to present dynamic lessons 
for every unit and chapter of The American Republic 
Since 1877 text.  Many of the teaching resources you 
have come to rely on—including full-color transparencies, 
Vocabulary PuzzleMaker, Interactive Tutor Self-
Assessment, and more—are now at your fingertips in this 
easy-to-use product.  Using Presentation Plus! and a Web 
browser, you also get instant access to online activities and 
resources at the tarvol2.glencoe.com Web site.

NOTE: The Presentation Plus! system is based on 
Microsoft PowerPoint 97 (Windows), but you do not 
need the PowerPoint 97 (Windows) software to use this 
tool since a Viewer program is included with the slide 
shows.  If you do have access to PowerPoint 97 (or a later 
version), you can customize your presentations.

Site License Agreement: By installing this software, you accept the terms and 
conditions of the McGraw-Hill Companies End User Software License Agreement. 
A copy of this agreement can be found on our Web site at www.epgtech.com, or 
on the CD-ROM under the filename LICENSE.TXT. This can also be attained by 
contacting our Software Support Hotline at 1-800-537-3715.
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Features of Presentation Plus!
Each slide show includes the following features:

 – View an extensive 
collection of regional and special-purpose 
maps.

 – Connect to a presentation 
that showcases all of the United States 
Presidents.

 – Connect to The 
American Republic Since 1877 Web 
site for additional activities and teaching 
suggestions.

 – Access current state 
profi les as needed in your instruction.

Unit Slide Shows
In addition to the features above, the unit slide 
shows may include the following features:

 – Take a look at relevant 
literature selections and how they pertain 
to American History.

 – All Cause and Effect 
transparencies are included in Presentation 
Plus!

 – Delve into the link 
between geography and history.

 – Step back with Time 
Notebook and see what people’s lives were 
like in the time periods being studied.

Chapter Slide Shows
Chapter slide shows may also include the 
following features:

 – Increase your students’ 
knowledge of technology with these 
activities.

 – Give your students the 
opportunity to increase their understanding 
of social studies.

 – Guide your students 
through activities to improve their critical 
thinking skills.

 – Work through these 
activities to help your students excel at 
studying and writing.



 – All Why it Matters 
transparencies are included in Presentation 
Plus!

 – Incorporate Glencoe’s 
PuzzlePlayer software into your lesson 
plans.

 – All Daily Focus Skills 
transparencies are included in Presentation 
Plus!

 – Examine the causes and 
effects of important events in history.

 – Add information to your 
lessons to build relevance and add interest.

 – Did historic events really 
happen the way you think they did? Utilize 
this feature to help your students fi nd out.

 – Connect lessons in history 
to other academic disciplines.

 – Hear about an interesting 
moment in history from National 
Geographic.

 – Use Glencoe’s Interactive 
Tutor Self-Assessment software to quiz 
your students.

 – Integrate the You Don’t 
Say feature into your lesson.

 – Connect lessons in history 
with technology of that time period.

 – Integrate The American 
Republic Since 1877 videos where they 
are relevant throughout Presentation Plus! 
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Installation Instructions
Windows 95/98/Me/2000
Installation Instructions 

1.  Insert the disc into the CD-ROM drive. 
If you have autorun turned on, the 
installer will run automatically.  In this 
case, skip to step 4.

2.  If autorun is turned off and the installer 
did not run automatically, click on 
the Start button and choose the Run 
option.

3.  Type the appropriate drive letter that 
corresponds with your CD-ROM drive.  
For example, d:\setup\setup and press 
Enter.

4.  Follow the directions on the screen to 
complete the process.

5.  After completing the installation, check 
to make sure that your monitor is set to 
high-color mode (thousands of colors) 
at 800 x 600 or higher resolution. 
•  With your mouse, right click on the 

Desktop.
•  Choose the Properties option.
•  Click on the Settings tab in the 

Display Properties dialog box.
•  Check the Color palette and Desktop 

area settings.
•  Change the settings if required.
•  Apply the new settings if you made 

any changes.

PowerPoint Viewer 97
Installation Instructions 

If you do not have PowerPoint 97 (or a 
later version) installed on your computer, 
install the Viewer 97 software provided on 
the Presentation Plus! CD-ROM.

1. Click the Start menu button and 
choose the Run option again.

2. Type “d:\Media Installers\PPView97” 
(include the quotes) and press Enter. 
(Remember to use the appropriate drive 
letter that corresponds with your CD-
ROM drive.)

3. Follow the instructions on the screen to 
complete the installation process.  

 (NOTE: You must install the 
PowerPoint Viewer onto your hard 
drive. Network installation is not 
supported.)
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Running Presentation Plus!
Setting Up your Equipment 

Before you begin using the Presentation 
Plus! system, check your equipment 
connections.  To use Presentation Plus!, 
you will need a computer (see System 
Requirements on page 9) and a projector or 
large-screen monitor capable of displaying 
high-color (800 x 600 or higher) images.

PowerPoint 97 (or a later version) 
Start-Up Instructions

If you have PowerPoint 97 (or a later 
version), you can use it instead of the 
Viewer to display the presentations. 
(NOTE:  Verify that your version of 
PowerPoint 97 is at least the SR-1 release 
by choosing About Microsoft PowerPoint 
in the Help menu of the program after it 
opens.  If your copy is not SR-1, or later, 
download and install a free update from 
www.microsoft.com)

1.  Start the PowerPoint software. Follow 
the instructions that came with the 
program.

2.  Choose to open a presentation.

3.  Select your CD-ROM drive.

4.  Choose a presentation (e.g., TAR2 Unit 
06, TAR2 Chapter 20).

5.  Select the Slide Show option to begin 
the presentation.

6.  When you start a presentation, you 
will see an opening slide. Click the 
Forward button to proceed to the next 
slide.

7.  From the Contents (or Main menu) 
slide, you can access many of the 
Presentation Plus! resources. While 
viewing a presentation, click the 
navigation buttons to view the slides. 
Click the Help button for step-by-step 
instructions.

8.  To end the presentation, click the Exit 
button or press the Esc (escape) key.

PowerPoint Viewer 97 
Start-Up Instructions

If you do not have PowerPoint 97 (or a 
later version) installed on your computer, 
follow the instructions to run the Viewer 
program. If you have not installed the 
Viewer, refer to the installation instructions 
on page 7.

1.  Make sure that your monitor is set to 
high-color mode (thousands of colors) 
at 800 x 600 or higher resolution. 
If your screen is not set properly, 
right click on the Desktop, choose 
Properties, and change the monitor 
settings.

2.  Click the Start menu button and 
choose the Programs option.

3.  Select Microsoft PowerPoint Viewer 
97 to start the Viewer program.

4. Click the Look in: pop-up menu and 
select your CD-ROM drive.



5.  Choose a presentation (e.g., TAR2 Unit 
06, TAR2 Chapter 20).  

6.  When you start a presentation, you 
will see an opening slide.  Click the 
Forward button to proceed to the 
next slide.

7.  From the Contents (or Main menu) 
slide, you can access many of the 
Presentation Plus! resources.  While 
viewing a presentation, click the 
navigation buttons to view the slides. 
Click the Help button for step-by-step 
instructions.

8.  To end the presentation, click the Exit 
button or press the Esc (escape) key.

System Requirements
• IBM PC (or 100%-compatible) 

computer
• Pentium 90 MHz microprocessor 
 (or higher)
• Windows 95 (or later)
• 4x CD-ROM (or faster)
• 16 MB memory (32 or more MB 

recommended)
• color monitor or projection device 

with high color (800 x 600 or higher) 
resolution

• video card (1 MB memory or better)
• hard drive (20 MB free)
• mouse or similar pointing device
• 28.8 modem (or faster) (optional, but 

needed to utilize some features)
• printer (optional, but recommended)
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Navigating the Software
Using the Presentation Plus! system is 
easy.  Once you select a presentation, 
just use a mouse or another compatible 
pointing device to step through a slide 
show.  As you view a slide show, you can 
use the following buttons/keys to navigate 
a presentation.

Use the Forward button to move 
forward one slide at a time through the 
software.  

Click the Back button to move 
back to the previous slide. 

  Click the Home button to display 
the Contents (or Main menu) slide.

To go to the beginning of a section 
or part, click the Section Start button.  
Depending on where you are working in 
a presentation, click this button to return 
to the slide from which you accessed a 
particular option.  

Click the Exit button or press the 
Esc (escape) key to end a slide show.
  

Use the Speaker button to listen 
to the audio provided in the presentations.

Click the Speaker Off button to 
turn any audio off.

Click the Help button to access 
step-by-step instructions on using 
Presentation Plus!

 Click the Map/Chart button to 
access maps and charts that pertain to the 
Lecture Notes you are viewing.

 Click the Map/Chart/
Photograph button to access maps, 
charts, and photographs that pertain to the 
assessment question you are viewing.

Press the Space Bar to display the next 
item on a slide. If the last item is already 
displayed, the program will display the 
next slide.

Use the Backspace key to move to a 
previous item on a slide.  If no items 
appear on a slide, the program will go to 
the previous slide.

The presentations also include hyperlinks.  
A hyperlink to another slide or to a 
different part of a presentation appears as 
yellow, underlined text.  When you click 
on a hyperlink, the program takes you 
immediately to the location associated 
with the link.  If you accidentally select a 
hyperlink, you can click the appropriate 
navigation button to return to where 
you were.  
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Teaching Tips
Presentation Plus! combines many of the 
teaching tools you are already familiar 
with in one complete package.  Listed 
below are a few teaching suggestions that 
may be helpful for presenting Presentation 
Plus!, especially if you have never used a 
PowerPoint presentation before now.

• Check your equipment setup before 
class begins.  Configure your computer 
system and projector so that they work 
properly with each other.  If you have 
a videodisc player, make sure that it is 
working properly too.

• Install the Presentation Plus! software.  
Follow the instructions for installation 
provided in this user guide.

• Work through at least one unit and one 
chapter presentation.  Check out all 
of the features.  Once you familiarize 
yourself with the flow and operation 
of one presentation, you will be ready 
to work with all of the others since 
they follow the same organization and 
navigation.

• Preview the presentations before 
using them in the classroom.  Use the 
teaching suggestions in the Teacher 
Wraparound Edition to help you 
develop a plan to integrate the 
presentation into your lesson plan.

• If you have Microsoft PowerPoint 
97 (or a later version), you can print 
the slides to use as handouts or as a 
teaching reference.  Open a presentation 

and choose Print from the File menu.  
Using the Print What pop-up menu, you 
can choose to print 2, 3, or 6 slides per 
page.  This will save time and paper 
when printing the slides.  All slides 
have been set up to print in black and 
white so that the text shows.  To print 
only selected slides, click on the Slides 
radio button and then enter the desired 
print range (e.g., 5-12).

• Refer to the Teacher Wraparound 
Edition and the print components 
that accompany the other integrated 
software components for teaching 
suggestions.

 
• Discuss proper note-taking techniques 

with your students.  Explain how to 
record important words, ideas, and 
phrases. The lecture notes that are 
provided as part of Presentation Plus! 
are not designed to be copied word for 
word.

 
• If you have Microsoft PowerPoint 97 

(or a later version), you can customize 
any of the slide presentations to meet 
your classroom needs.  You can edit 
slides, add new ones, and delete 
unneeded slides. See page 12 for more 
information.



Presentation Plus! The American Republic Since 1877 12

Customizing a Presentation
The Presentation Plus! software was 
created using Microsoft PowerPoint 97.  
Although you do not need PowerPoint 
97 to view the slides, you can customize 
any of the presentations if you have 
PowerPoint 97 (or a later version).  Follow 
the steps listed below to customize a 
presentation.

To customize a presentation:

1. Install PowerPoint 97 (or a later 
version) on your computer if it is not 
already installed.

 IMPORTANT:  If you are not 
thoroughly familiar with PowerPoint, 
practice creating your own 
presentations.  You could also work 
through a tutorial to learn how to use 
the powerful features available in this 
program.

2. Before you make any changes to a 
PowerPoint presentation, you should 
create a folder on your hard drive.

3. Since you cannot make changes to the 
presentations on the CD-ROM, copy 
the presentation(s) to your hard drive.  
Copy them to the folder you have 
created.  Relevant video and linked 
presentations will need to be copied 
into the folder as well.

 If you have enough hard disk space, 
you can copy all of the presentations 
and video to your hard drive.  
Approximately 650 MB disk drive 
space is needed.  Each presentation 
includes all of the art, audio, and links 
in its own file.  

4. Since you copied the files from a CD-
ROM, they are set to read-only.  If you 
change a slide show, you must save it 
under a different name; you can also 
use Microsoft Windows Explorer to 
change the properties for these files.  
Right-click on a file name that you 
copied to your hard drive, choose 
Properties, and then turn off the read-
only attribute.

5. Customize the presentation to meet 
your classroom needs.  Refer to the 
suggestions and tips listed below 
before you make any changes to a 
presentation.

• If you have deleted any art element 
(e.g., a button or a picture) from 
a presentation, you will need to 
copy the element from another 
presentation or slide within the 
current presentation if you want to 
insert the element back into a slide 
show.  Separate art elements are not 
provided as part of Presentation 
Plus!

• All of the chapter and unit 
presentations use the custom show 
feature for all features accessed 
through buttons on the left side 
of the slides. You should fully 
understand how custom shows 
function before making any 
modifications to these slides.  If, 
for example, you add a slide to a 
feature, you must also update the 
corresponding custom show list so 
that PowerPoint will know how to 
display the new slide.
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• Changes to the Chapter 
Introduction, Lecture Notes, and 
Chapter Assessment slides can 
easily be made since these slides are 
not part of a custom show.  You can 
add slides, delete slides, and update 
slides as needed.

• Hyperlinks and action settings 
are used to control the action for 
many of the buttons found in a 
presentation.  Making changes to a 
hyperlink action setting is relatively 
straightforward.  However, 
a special launcher program 
(fscstart.exe) controls how the 
Puzzles, Interactive Tutor Self-
Assessment Software (ITSA), 
Help, and the Internet Connect 
buttons operate.  If you change 
any of these buttons or add new 
buttons, you need to understand the 
syntax for the launcher program.  To 
use the launcher program, choose 
to assign an action setting to an 
object.  Indicate that you want to 
add a setting that runs a program.  
Enter the launcher program name 
along with the appropriate switch to 
perform the desired action. 

To start the puzzle software, use...   fscstart /ar2 /1 /fsc

To start ITSA, ...   fscstart /ar2 /2 /fsc.[unit#].[chapter#].[section#]

To display the help information, ... fscstart /ar2 /3 101

To launch tarvol2.glencoe.com, ... fscstart /ar2 /5 /111
   
** Place the correct numeric value in place of the brackets and information contained  

within them. 
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Troubleshooting Tips
Glencoe provides toll-free telephone assistance for teachers who experience difficulty while 
using our software or templates.  Before calling for assistance, please check the following:

• Is your computer working properly?  On the same computer, try some other software that 
you know is working.

•  Can you repeat the problem? 
•  Does the problem occur at the same point each time?
•  Review the list of troubleshooting tips below to see if your problem is identified.

In order for the Support Center to help you as quickly as possible, have the following 
information at hand when you call for assistance:
 
•  exact title and ISBN number of the software from the disk label or package
•  brand, model, and configuration of the computer and printer you are using
•  version of the operating system installed on your computer
            
The Glencoe Support Center toll-free number is 1-800-437-3715.  The Support Center is 
available from 8:00 a.m. to 6:00 p.m. Eastern Time.  You can also contact the Support Center on 
the Internet at the following e-mail address:  epgtech@mcgraw-hill.com

Using the Help System

In addition to the Glencoe Support Center, an extensive Help system is incorporated into 
Presentation Plus!  Whenever you need help, just click the Help button to display step-by-step 
instructions. 

If the appropriate topic does not appear, click on the Contents button to see the table of contents 
for the Help system.  Or, click on the Search button to find a particular topic.

Troubleshooting Tips

The presentation is difficult to read when displayed on a screen. 
The quality of the images projected through PowerPoint depends on several factors.  Make sure 
that you are displaying the image onto a reflective surface—not a blackboard or other similar 
surface.  Using a better screen can greatly improve the display quality.  Darken the room if 
possible.  Check the quality of your projector.  This, too, greatly impacts the display quality.

The navigation buttons do not seem to work properly.
Click the Exit button or press the Esc (escape) key to exit the slide show.  If you are using 
the Viewer, choose the presentation again to start the slide show at the beginning.  If you are 
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using PowerPoint 97, press the Home key to scroll to the first slide in the presentation and then 
choose Slide Show in the View menu to start the presentation at the beginning.

Clicking Exit in an ancillary presentation does not go back to the original presentation.
Your version of PowerPoint 97 is not the latest version.  Use the PowerPoint Viewer that is 
included on your Presentation Plus! CD-ROM to view presentations or download the latest 
Microsoft Office 97 Service Release from http://officeupdate.microsoft.com

Clicking the right mouse button does not move backward.
Using the Viewer, click on the Options button that appears when you first start the Viewer.  
Change the settings so that a right-click does not display the pop-up menu.  Using PowerPoint 
97, click on the Tools menu, choose Options, and click on the View tab.  Turn off the setting so 
that the pop-up menu does not appear on right-clicks.

Colors on the slides do not seem correct.
The Presentation Plus! software requires that you set your monitor to high-color (16-bit) or 
better.  If your monitor is set for 256-colors, the quality of the images as they appear on your 
screen may not be very good.  (See the next tip for instructions on how to check or change your 
color settings.)

How do you set the screen resolution and colors?
Depending on your computer system and projector, you may need to set your monitor to 
640 x 480 resolution.  Using these instructions, you can also change the color setting.  Right-
click on the Desktop.  From the pop-up menu, choose Properties, and then click on the 
Settings tab.  Make the necessary changes on the Settings screen. 

The highest color setting mode is 256-colors. 
For best results, upgrade your video card and driver to support high-color (16-bit) mode or 
better.  If you are using a SuperVGA monitor, you should not have to change your monitor.  The 
various levels of color settings are more a factor of the video card and how much memory it 
has.

While viewing a presentation, some portions of the screen are not updated. 
Ideally you want to display Presentation Plus! at 800 x 600 or higher resolution. Some video 
drivers may have difficulty displaying full-color slides in 800 x 600 (or higher) resolution.  An 
update to your video driver may be available from the equipment vendor.  If updating your 
video driver does not correct the problem, right-click on the Desktop.  From the pop-up menu, 
choose Properties and then click on the Settings tab.  Change the resolution to 640 x 480.  You 
may also have to change your projector equipment to display in the same mode.  

The text is not clear on the projected image, but the text is okay on the monitor. 
The resolution for a projector needs to match the resolution for your monitor.  If your monitor 
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is set to 800 x 600, for example, text may look squeezed on a projected image.  Refer to your 
projector’s manual for instructions on setting the display resolution.

Audio segments do not play. 
Make sure that your speakers are turned on and that the volume is set properly.  On some 
versions of Windows 95, there is a small speaker icon in the lower, right corner of your screen.  
Click on it and then adjust the volume settings if necessary.  If the audio files still do not play 
but other WAV files play correctly on your machine, you may need to install the correct audio 
CODECs.  In Windows, Click Start, Settings, Control Panels, Add New Hardware.  Click 
No when asked if you want Windows to search for new hardware.  Select Sound, Video, and 
Game Controllers, choose Microsoft Audio Codecs under manufacturers, and select the 
ADPCM Codec.  Follow the directions on the screen and insert the Windows disc if necessary.

When the program displays a new slide, the mouse pointer does not immediately appear. 
This is a function of PowerPoint.  After a new slide appears, move the mouse a few times to get 
the pointer to appear.  PowerPoint won’t show the mouse until you move it so that the pointer 
does not interfere with your presentation.

Long delays seem to occur randomly while viewing a presentation using Microsoft 
PowerPoint 97 (or a later version).
If you are using PowerPoint 97 (not the Viewer), you may want to turn off the AutoRecovery/
AutoSave feature.  To do this, choose Options from the Tools menu, select the Save tab, and 
turn off the appropriate option. Since the presentations are quite large, saving the files may 
require a few moments.  If you are viewing a presentation at that time, the slide show will 
appear not to respond.  Even though you are viewing a slide, Microsoft PowerPoint 97 will still 
autosave any open files according to the set parameters.

A delay may also occur when you click on the Connect button.  Clicking on this button 
launches your browser, dials your phone (if necessary), and connects to the textbook’s Web site.  
Depending on the speed of your computer, a few minutes may be required.

PowerPoint has difficulty displaying a presentation stored on a network drive or CD-ROM 
network server. 
Presentation Plus! must be installed locally on each computer that will run the presentations. 
Check to make sure that all relevant video and linked presentations are in the same directory 
with the main presentation you are trying to run. There may be noticeable delays running from a 
network. These delays can be caused by network speed, network traffic, or the server. See your 
network administrator if you are having difficulties. 

Clicking the Connect button does not launch your Web browser. 
You must have Netscape 4.0 or Explorer 4.0 (or later versions) installed on your computer.  
When you click on the Connect button, a minute or two may be needed for the Web browser 
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to launch and connect to the Internet.  If you don’t have enough memory or you experience 
problems with the connection, the Web browser may not start properly.  You can quit the 
Presentation Plus! software and manually launch your Web browser.  Then go to the Web site 
that is specified on the slide.

A memory overflow error appears when printing slides, or only a portion (e.g., half) of a slide 
prints. 
If you try to print a slide that includes large art elements, your printer may display a memory 
overflow error or the printer may only print a portion of a slide.  First, make sure that you are 
printing in the black and white mode.  All of the presentations have been optimized so that only 
the most important information prints.  Background art should be turned off.  If you add your 
own slides, this may not be the case.  Choose Black and White from the View menu.  Then 
right-click on an object and set its black and white format.  For example, you can choose not to 
show an object in black and white mode.

Another option to try is to set the Print What: field in the Print dialog box.  Choose to print 
handouts (2 or 3 handouts per page).  This option may also alleviate printing problems.

If you want to print slides with all of the art elements, you may need to add more memory to 
your printer.  See the manual that accompanies your printer for more information.

The screen goes black when you attempt to view the show.
PowerPoint 2000 loads the entire presentation into memory when you begin to view the show. 
This causes a delay of up to a minute or two when you start a presentation.

Answers are not provided for the crossword puzzles.
If you want to print the answers for a puzzle, click on the Start button and choose Run.  Type 
d:\extras\puzzles\pzmaker and press Enter to start the PuzzleMaker program.  (Be sure to 
use the drive letter that corresponds to your CD-ROM drive.)  After the program starts, choose 
to open a puzzle.  Select the puzzle you want and then choose to print it.  Exit the program 
when you are finished.

A slide show does not work properly after making changes to a presentation.
The Presentation Plus! slide shows contain many hyperlinks and action settings.  Make sure 
that you did not accidentally delete or change any of these.  To check for missing slides, use the 
Slide Sorter view.  In this mode, you can view several slides at one time. 

All of the chapter and unit presentations use the custom show feature for all features accessed 
through buttons on the left side of the slides (unless they are a linked presentation).
You should fully understand how custom shows function before you make any changes to 
these slides.  If, for example, you add a slide to one of these parts, you must also update the 
corresponding custom show list so that PowerPoint will know how to display the new slide.
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None of the troubleshooting tips solve the problem.
If you have not customized the presentations, call the Glencoe/McGraw-Hill technical support 
number listed at the beginning of this section.

If you have difficulty customizing a presentation, you may want to access the Microsoft Web 
site at http://www.microsoft.com for assistance with your problem.  At this Web site, you can 
search through an online support database.  Another excellent source for help is the Microsoft 
PowerPoint discussion group at microsoft.public.powerpoint

Notes:
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